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These release notes contain system requirements for NI Circuit Design 
Suite 10.1, and information about product tiers, new features, 
documentation resources, and other changes since NI Multisim 10.0.1
and NI Ultiboard 10.0.1. 

NI Circuit Design Suite includes the familiar NI Multisim and NI Ultiboard 
software products from the National Instruments Electronics Workbench 
Group. The NI Multisim MCU Module functionality is now included with 
NI Multisim. 
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Installing NI Circuit Design Suite 10.1
This section describes the system requirements and installation procedures 
for NI Circuit Design Suite. 

Minimum System Requirements
To run NI Circuit Design Suite 10.1, National Instruments recommends 
that your system meet the following requirements: 

• Windows 2000 Service Pack 3 or later, Windows XP, Vista, or 
64-bit Vista.

• Pentium 4 class microprocessor or equivalent (Pentium III class 
minimum).

• 512 MB of memory (256 MB minimum). 

• 1.5 GB of free hard disk space (1 GB minimum).

• Open GL® capable 3D graphics card recommended (SVGA resolution 
video adapter with 800 × 600 video resolution minimum, 1024 × 768 
or higher preferred).

• To develop custom LabVIEW based instruments for use in Multisim, 
LabVIEW 8.2.x or 8.5.x is required. 

Installation Instructions
The NI Circuit Design Suite 10.1 installer installs all products in the suite: 
NI Multisim and NI Ultiboard. 

National Instruments recommends that you close all open applications 
before you install NI Circuit Design Suite.



© National Instruments Corporation 3 NI Circuit Design Suite Release Notes

Unless you specify another location during installation, the NI Circuit 
Design Suite installation program copies files to <Program Files>\
National Instruments\Circuit Design Suite 10.1 after you 
complete the following steps:

1. Insert the NI Circuit Design Suite CD into the CD-ROM drive. If the 
CD startup screen is not visible, select Run from the Windows Start 
menu and run setup.exe from your CD drive. 

2. Follow the instructions in the dialog boxes. 

Note On completion of the NI Circuit Design Suite (NI CDS) 10.1 installation, the 
installer prompts you for the NI ELVISmx 4.0 installation CD, which is included in your 
NI CDS package. The NI ELVISmx 4.0 enables the NI ELVIS II functionality in Multisim. 
If you wish to install the NI ELVISmx 4.0 software, follow the instructions in the prompt. 
Otherwise, you can install the NI ELVISmx 4.0 software at a later time. Refer to the Virtual 
NI ELVIS II and NI ELVIS Instruments sections for more information. 

Product Activation
When you run a product in NI Circuit Design Suite for the first time, it will 
prompt you to activate a license for that product. 

If you do not activate a valid license, the product will run in Evaluation 
Mode and continue to prompt you to activate a license on each subsequent 
run. Evaluation Mode is valid for 30 days following the first run of the 
product.

For information about how to activate your software product, please refer 
to the Activation Instructions for National Instruments Software Note to 
Users included with your NI Circuit Design Suite 10.1 package. 

What’s New in NI Circuit Design Suite 10.1
This document describes the following feature additions or improvements 
to NI Circuit Design Suite 10.1:

• The Multisim Automation API.

• Virtual NI ELVIS II.

• NI ELVIS instruments.

• Enhancements to NI LabVIEW instruments in Multisim.

• Additions to the component database.

• Extended SPICE modeling capabilities.

• NI Update Service.

• Vista compliance.
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• Support for TDMS data files.

• File compatibility with NI Circuit Design Suite 10.0.x.

• Virtual NI ELVIS II 

• New font rendering in NI Ultiboard.

The NI Multisim Automation API
The NI Multisim Automation API allows the automation of simulation 
and analyses through a COM interface. This is useful when a number of 
simulation runs are required with different circuit settings. Examples 
include such tasks as component analysis, stress analysis, and fault 
analysis. 

The Multisim Automation API lets you programmatically control a 
Multisim simulation without needing to view Multisim. Clients written
in any COM-aware programming language, such as NI LabVIEW, 
Visual Basic, or C++ can access Multisim through this interface. 

Through the API, you can:

• Open and close an existing circuit.

• Optionally inject a signal in place of an existing voltage or current 
source.

• Start, stop, and pause simulations.

• Read out simulation results from an existing static probe.

• Enumerate the components in the schematic.

• Replace components with components from the database.

• Get and set the values of resistor, capacitor, and inductor components.

• Enumerate variants.

• Get and set the active variant for simulation.

• Generate reports on the schematic, including a bill of materials and a 
netlist report.

• Produce an image of the circuit.

Notes: 

• Simulation settings used during API control simulations are taken 
from the Transient Analysis settings of the chosen circuit. Any changes 
to the Interactive Simulation settings are ignored. 

• The API can only change and replace components on the top level of a 
design; components in sub-circuits and hierarchical blocks cannot be 
altered. 
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• Multisim component replacements may not always have the expected 
result—they should always be tested in an interactive session of 
Multisim to make sure that the behavior is what is required.  

• Multisim Fault settings cannot be changed through the API. Fault 
analysis requires the building of circuits with additional resistive 
elements and setting the elements to zero or large values. 

Virtual NI ELVIS II
NI Multisim 10.1 includes new functionality to complement the 
introduction of the NI ELVIS II. The Virtual NI ELVIS II builds on the 
functionality of the Virtual NI ELVIS found in previous releases of the 
software. NI ELVIS II functionality is activated in Multisim after you 
install the NI ELVISmx 4.0 software. You can now choose to start from 
either a new NI ELVIS or NI ELVIS II schematic. The selection of 
schematic template will affect which of the 3D NI ELVIS models is 
used in the breadboard mode. Select File»New»NI ELVIS II to select the 
NI ELVIS II template. 

In addition to the new schematic template and new 3D model, NI Multisim 
now leverages the NI ELVISmx 4.0 Soft Front Panels (SFP) inside of 
Multisim. 

Note that NI ELVIS II refers to the hardware revision number and 
NI ELVISmx 4.0 refers to the software revision. 

Note To take full advantage of the integration of NI ELVIS II and Multisim, you must also 
install the NI ELVISmx 4.0 software. 

NI ELVIS Instruments
In previous releases, native Multisim instruments were used to replicate 
the  types of measurements performed with the real world NI ELVIS. 
NI Multisim now hosts the NI ELVIS II Soft Front Panels (SFP) used with 
the instrument hardware. These instruments allow you to show both 
simulated and real measured data on the same display. 

There are two ways to invoke an NI ELVIS II SFP: you can access them 
from either the rails or the top of an NI ELVIS II schematic template, or you 
can drop them onto any Multisim schematic from the NI ELVIS 
Instruments toolbar.
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Limitations of NI ELVIS II in Multisim 10.1
Multisim does not support all of the NI ELVIS 4.0 SFPs in the 10.1 release.  
Instruments that provide frequency response information, such as the Bode 
Analyzer, and those that provide impedance and current measurements are 
not supported. 

Enhancements to NI LabVIEW Instruments in NI Multisim
LabVIEW instruments in Multisim let you create custom input, output, 
and  input/output instruments for use in Multisim. Improvements in 
Multisim 10.1 include support for both input and output pins on the same 
instrument, continuous data out to Multisim from output instruments, and 
the ability for input instruments to affect the time step and interpolation 
method used in simulation.

Input and Output Instruments
Previous releases allowed input-only and output-only instruments. 
Input/output instruments have all of the capabilities of input-only and 
output-only instruments. Note, however, that LabVIEW instrument input 
data is lagging (meaning that it arrives at the instrument in discrete chunks 
after the simulator has produced the data), and streaming-out data is leading 
(meaning that the simulator requests the data in discrete chunks before 
it needs it). This means that tight feedback loops where a LabVIEW 
instrument’s output depends instantaneously on its intput are not possible. 
In general, it will take at least one extra set of continuous outputs through 
the “Update Data Get Output Values” event of the instrument before you 
can be sure that the input received by that instrument reflects an adjusted 
output signal. 

Continuous Data from Output Instruments
Previously, data output instruments could generate a finite set of possibly 
repeating data. When creating an output instrument that generates data 
continously, remember that, in general, Multisim simulates circuits at a rate 
slower than the real-time behavior of an equivalent physical circuit. 
Therefore, if you create an instrument that continuously acquires 
real-world data using a data acquisition device, modular instrument, or 
other similar hardware, and use that data as a simulation source in 
Multisim, simulation will not be able to keep up with the acquired data 
because it will be running at a rate slower than the data acquisition. 

It is the responsibility of the output instrument creator to generate 
sufficiently small chunks of data at a rate that allows Multisim simulation 
to keep up with the data acquisition.
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Affecting the Time Step and Interpolation Method
LabVIEW samples and processes data at even time steps. SPICE generally 
operates at uneven time steps best suited to convergance and speed. When 
creating an input instrument, it is neccesary to resample the data to evenly 
spaced data for use in LabVIEW. You can now create an instrument that 
uses Force Step interpolation. (Force Step is not strictly an interpolation 
method. It forces the Multisim SPICE simulator to take additional 
timesteps that line up with the requested sampling rate).  

If a particular LabVIEW instrument allows you to set the sampling rate 
and/or interpolation method, Multisim 10.1 recognizes changes to these 
values during simulation. 

Increased Quality and Breadth of the Component Database
Multisim 10.1 includes new additions and improvements to the database. 
These include around 300 new components from leading manufacturers, 
more than 500 updated components, and the latest generic power 
simulation parts. 

New Components from Leading Manufacturers
There are around 300 new components with models from Analog Devices 
and Texas Instruments. The additions include symbols, models, and IPC 
compliant land patterns. These components include operational-amplifier, 
comparator, analog switch, and voltage reference models.

Generic Power Simulation Parts
Multisim 10.1 includes models for all freely available power simulation 
parts found in the latest release of “Switch-Mode Power Supplies Spice 
Simulations and Practical Designs” by Christophe Basso. These 
components include Buck, Boost, Buck-Boost, and PWM controllers.

Extended SPICE Modeling Capabilities
Multisim 10.1 introduces enhancements to its SPICE modeling 
capabilities. The SPICE parser has been redesigned and improved to better 
support multiple SPICE languages and advanced modeling. Multisim also 
supports more Cadence® PSpice® parameters. There is also improved 
XSPICE model error reporting.
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Redesign and Improvement of the NI Multisim SPICE 
parser
The SPICE parser in Multisim interprets the native SPICE net lists, reports 
syntax errors, and evaluates mathematical expressions. Enhancements to 
the parser include:

• Improved syntax and simulation compatibility for controlled sources.

• Table sources.

• Numerous compatibility improvements that enhance the ability to 
support Cadence® PSpice® and Intusoft IsSpice4™ syntax.

• Flexible component, net, terminal, and model names.

– Names may contain any characters with the exception of white 
space and the following characters: " ' ( ) { } [ ] , # $: ;

• The ability to use expressions in place of any value in the netlist.

– The two special exceptions to this are the BSIM level param and 
the POLY number in a controlled source. 

• Improved support for expressions, including:

– Support of inline if statements.

– Improved support for .param statements.

– Full support of single and nested .func statements.

– Current through diodes and relevant controlled sources can now 
be used in expressions (for arbitrary sources).

– Improved convergence for complex behavioral-modeling style 
circuits.

Improved SPICE Model Error Reporting
More intelligent error messages are presented for errors relating to SPICE 
models. 

Component terminals, parameters and expressions are now checked in 
depth before the simulation begins. Simulation errors display in the 
Simulation tab of the Spreadsheet View and identify the Multisim 
components that are causing the issue. 

Note With the exception of the Simulation tab and the Results tab, the Spreadsheet View 
is not available in the Student edition of Multisim. Refer to the Multisim help file for 
information about these tabs. 
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Improvements to Cadence® PSpice® Compatibility
Multisim 10.1 now supports the following Cadence® PSpice® parameters 
for MOSFETS and BJTs: 

NI Update Service
The new NI Update Service helps keep your National Instruments software 
and drivers up-to-date. NI Update Service, which replaces the existing 
Support and Upgrade Utility (SUU), checks for and electronically delivers 
software updates for your NI software. You can launch NI Update Service 
at any time to check for updates or determine the most recent time updates 
were installed. 

Windows Vista Compliant
NI Circuit Design 10.1 is Windows Compliant. Version 10.0.1 was Vista 
compatible but continued to write to the Program Files directory during 
run-time. Multisim 10.1 follows Vista Compliance Guidelines.

Better Storage of User Fields from the Master 
Database
User fields associated with components stored in the Master database are 
now stored separately. You will see no visible impact when editing and 
working with user fields in Multisim. This will, however, help to preserve 
data as you migrate from version to version. This is also required for Vista 
compliance.

Parameter Description Device

m Device multiplicity parameter MOSFET

Rg, Rb Gate and Bulk Ohmic Resistance MOSFET

Rds Drain-Source Shunt Resistance MOSFET

W, L Width and Length support on 
.model line

MOSFET

Nk Knee current roll-off coefficient BJT
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Support of TDMS Data Files
Multisim now supports TDMS files. TDM voltage and current sources can 
reference TDM streaming data files and the Multisim Grapher can export 
TDMS data.

Files are Compatible with NI Circuit Design Suite 10.0.x
Files from NI Circuit Design Suite 10.0.x and 10.1 are backward and 
forward compatible. File extensions remain the same; files saved with 
either version will open in both versions.

New Font Rendering in NI Ultiboard
Fonts placed on layers on the board in Ultiboard are now drawn using 
anti-grain geometry. This provides faster font rendering and better 
anti-aliasing. 

Localization
NI Circuit Design Suite 10.1 is localized for English, German, and 
Japanese. The system locale setting determines the default language 
used by the software. 

To change the default language the software uses, select Options»Global 
Preferences, click on the General tab, select the desired locale from the 
Language combination box, and restart the application. 

The following items are not localized, and remain in English: 

• LabVIEW instruments.

• NI ELVIS instruments.

• Layer names in both NI Ultiboard and the NI Multisim 
Spreadsheet View.

• Agilent and Tektronix simulated instruments.

• Sample files.

• MCU functionality: source file names, code/comments within source 
files, and compiler/linker messages.

The following documentation is available in English, German, and 
Japanese:

• Release Notes.

• Getting Started with NI Circuit Design Suite.

User manuals and help files are not localized, and remain in English. 
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Product Tier Details
The following lists the schematic capture functionality available in 
Multisim Student and Education editions:

Functionality Student Education

Customizable GUI X X

Screen-capture utility X X

Comments on schematic X X

Circuit annotations X X

Modeless part placement and wiring X X

Fast retrieval parts bins X X

Auto and manual wiring X X

Virtual wiring by node name X X

Rubber banding on part move X X

Fast auto-connect passives X X

Subcircuits X X

3-dimensional breadboarding X X

Virtual NI ELVIS I and II X X

Embedded questions—view 
and respond

X X

Forward/Back annotation 
with Ultiboard

X X

Cross-probing with Ultiboard X X

Bus-vector connect X

Spreadsheet view X

Design constraints X

Advanced search X

Zoom to selected part X

Corporate database X

User defined fields X
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The following lists the simulation functionality available in Multisim 
Student and Education editions:

Save components to database from 
workspace

X

Multiple circuits open X

Embedded questions—create 
and edit

X

Electrical rules check X

Graphically mark no-connect pins X

Hierarchical designs X

Multisheet designs X

Project manager X

Reports—including bill of materials X

Pin and gate swap X

Export to Mentor PADS layout X

Device library Partial Complete

Maximum components in design 50 Unlimited

Functionality Student Education

Interactive simulation X X

Fully mixed-mode A/D simulation X X

Standard SPICE 3X5/XSPICE X X

Enhanced model support X X

Cadence® Pspice® model simulation* X X

Speed/Accuracy tradeoffs X X

Simulation advisor X X

Convergence assistant X X

Virtual, interactive, animated parts X X

Mouse click support for 
interactive parts

X X

Functionality Student Education
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Rated components X X

Insert faults into components X X

Measurement Probes X X

Component Wizard X X

NI measurement data file sources X X

NI measurement data file export X X

NI LabVIEW VIs as 
instruments and sources

X X

Microphone & speaker X X

Circuit restrictions X X

Grapher & Postprocessor X X

RF design kit X X

Circuit wizards X

C-Code modeling X

Description box synced 
with simulation

X

Ladder diagrams/components X

Model makers X

Load and save simulation profiles X

Virtual Instruments 22 22

Analyses 10 18

Multisim MCU X X

Multisim Automation API X

* Does not support all Cadence® PSpice® syntax

Functionality Student Education
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The following lists the layout functionality available in Ultiboard Student 
and Education editions:

Functionality Student Education

Push and Shove trace placement X X

Push and Shove part placement X X

Real-time & from copper ratsnest X X

Real-time polygon update with 
voiding

X X

Forward/Backward annotation X X

Cross-probing with Multisim X X

Real-time DRC X X

64 layers and 1 nanometer resolution X X

Comprehensive Footprint Wizard X X

Enhanced 3D visualization with print X X

User annotations X X

Full  screen mode X

Gerber, DXF, IPC-D-356A, 
SVG output

X

Dimensions on PCB and Landpatterns X

Dimensions in Database Manager X

Net bridges X

3D visualization inside circuit board X

Turn off ratsnest for selected nets X

Gridless follow-me placement X

Load and save technology files X

Polar Grids X

Customizable layer viewing X

Split power-planes X

Keep-in/Keep-out areas X

Place components in array X
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Unplace all components X

Ruler bar alignments and 
measurements

X

Auto-alignment X

Save PCB Design as a component X

Permanent grouping X

Pin & gate swapping X

Multiple clearances X

Jump to Error X

Equispace trace support X

Differential Impedance Calculator X

Transmission Line Calculator X

Microvias X

Test point insertion X

Automatic tear-dropping X

Pin necked trace support X

Automatic jumper insertion X

Copy Route & Replica Place 
functions

X

In-place footprint editor X

Mechanical CAD X

Export 3D info in 3D IGES, DXF 
formats

X

Copper amount report X

Test point report X

Customization of report generation X

Multiple open documents X

Number of pins supported 350 1,000

Spreadsheet view Limited Complete

Functionality Student Education
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The following lists the autorouting functionality available in Ultiboard 
Student and Education editions:

Functionality Student Education

Fully customizable cost factors X X

Progressive Routing X X

Interactive autorouting X X

Constraint driven routing X X

Manual pre-placement: components, 
vias, traces

X X

Auto Block Capacitor recognition X X

SMD mirroring X X

Trace rubberbanding X X

Follows keep-in/keep-out criteria X X

Pin number limit 350 1,000

Maximum number of layers 2 4
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Documentation
NI Circuit Design Suite 10.1 includes a complete documentation set 
featuring printed and electronic resources for your reference.

The following printed and electronic resources are available:

• Getting Started with NI Circuit Design Suite.

• NI Circuit Design Suite Release Notes.

The following electronic resources are available in PDF files:

• Multisim User Manual.

• Multisim for Education Manual.

• Ultiboard User Manual.

Note Because the NI Multisim MCU Module functionality is now included with 
NI Multisim, the Multisim MCU Module User Guide has been discontinued. Refer to the 
Multisim User Manual for information about Multisim MCU. The Multisim Component 
Reference Guide has been discontinued. Refer to the Component Reference Help File for 
information about components. 

To access the User Manuals, select Start»All Programs»National 
Instruments»Circuit Design Suite 10.1»Documentation and then select 
the file of interest. 

The following online help files are available from the installed software 
Help menu and from the Start menu: 

• Multisim Education Edition Help File.

• Ultiboard Help File.

To access the Help files, from the Start menu, select Start»
All Programs»National Instruments»Circuit Design Suite 10.1»
Documentation and then select the file of interest. 

The following online help files are available from the installed software 
Help menu: 

• Component Reference Education Edition Help File.

• Multisim Symbol Editor Help File (access from the Symbol Editor).

• Multisim Title Block Editor Help File (access from the Title Block 
Editor). 



 

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section on 
ni.com/legal for more information about National Instruments trademarks. Other product and company names mentioned herein are 
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© 2007–2008 National Instruments Corporation. All rights reserved. 374479C May08



VERSIONSHINWEISE ZUR SCHULUNGSVERSION

NI Circuit Design Suite
Version 10.1

In der vorliegenden Broschüre werden die Systemvoraussetzungen zur 
Installation der NI Circuit Design Suite 10.1 beschrieben und Sie finden 
Informationen zu den einzelnen Produktversionen und allen Neuerungen 
seit NI Multisim 10.0.1 und NI Ultiboard 10.0.1. 

Die NI Circuit Design Suite umfasst die bekannten Anwendungen 
NI Multisim und NI Ultiboard der National Instruments Electronics Work-
bench Group. Das Multisim-MCU-Modul ist nun in NI Multisim enthalten. 
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Installation der NI Circuit Design Suite 10.1
Nachfolgend werden die Systemvoraussetzungen und Hinweise zur Instal-
lation der NI Circuit Design Suite beschrieben. 

Mindestvoraussetzungen zur Installation
Um die NI Circuit Design Suite 10.1 problemlos ausführen zu können, 
sollte Ihr System die folgenden Voraussetzungen erfüllen: 

• Windows 2000 mit mindestens Service Pack 3, Windows XP, Vista 
oder 64-Bit-Vista.

• Pentium-4- oder gleichwertiger Mikroprozessor (mindestens 
Pentium 3).

• 512 MB Arbeitsspeicher (mindestens 256 MB). 

• 1,5 GB freie Festplattenkapazität (mindestens 1 GB).

• Open-GL®-fähige 3D-Grafikkarte (Videoadapter mit SVGA-Auflö-
sung mit einer Videoauflösung von mindestens 800 × 600 – empfohlen 
werden jedoch mindestens 1024 × 768).

• Zum Erstellen eigener virtueller LabVIEW-Instrumente für Multisim 
ist LabVIEW 8.2.x oder 8.5.x erforderlich. 

Installationsanleitung
Mit dem Installationsprogramm der NI Circuit Design Suite 10.1 werden 
NI Multisim und NI Ultiboard installiert. 

Es wird empfohlen, vor Installation der NI Circuit Design Suite alle geöff-
neten Anwendungen zu schließen.

Sofern Sie kein anderes Installationsverzeichnis angeben, wird die
NI Circuit Design Suite in das Verzeichnis <Programme>\National 
Instruments\Circuit Design Suite 10.1 installiert.
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1. Legen Sie die CD mit der NI Circuit Design Suite in das 
CD-ROM-Laufwerk ein. Wenn das Installationsprogramm nicht auto-
matisch startet, klicken Sie im Start-Menü von Windows auf 
Ausführen und starten Sie die Datei setup.exe auf der CD. 

2. Folgen Sie den Anweisungen auf dem Bildschirm. 

Hinweis Nach Abschluss der Installation der NI Circuit Design Suite (NI CDS) 10.1 for-
dert Sie das Programm dazu auf, die Installations-CD für NI ELVISmx 4.0 einzulegen, die 
Teil Ihres NI-CDS-Pakets ist. Mit NI ELVISmx 4.0 können Funktionen von NI ELVIS II 
in Multisim genutzt werden. Folgen Sie einfach den Installationsanweisungen. Sie können 
NI ELVISmx 4.0 auch zu einem späteren Zeitpunkt installieren. Weitere Informationen 
finden Sie in den Abschnitten NI ELVIS II (virtuell) und Instrumente von NI ELVIS. 

Produktaktivierung
Bei erstmaliger Ausführung eines Programms der NI Circuit Design Suite 
werden Sie zur Lizenzaktivierung für das betreffende Programm 
aufgefordert. 

Wenn Sie keine gültige Lizenz aktivieren, läuft das Programm im Evaluie-
rungsmodus und Sie werden bei jedem Start des Programms nach einer 
Lizenz gefragt. Der Evaluierungszeitraum beträgt 30 Tage.

Informationen zur Aktivierung des Programms erhalten Sie in der Aktivie-
rungsanleitung für Software von National Instruments, die der NI Circuit 
Design Suite 10.1 beiliegt. 

Neue Funktionen der NI Circuit Design Suite 10.1
Die NI Circuit Design Suite 10.1 wartet mit folgenden neuen Programm-
funktionen bzw. Verbesserungen auf:

• Neue ActiveX-API in Multisim

• NI ELVIS II (virtuell)

• Instrumente von NI ELVIS

• Verbesserungen von LabVIEW-Instrumenten in Multisim

• Erweiterte Bauelemente-Datenbank

• Verbesserte SPICE-Modellierung

• NI Update Service

• Vista-Tauglichkeit

• Unterstützung von TDMS-Dateien

• Dateikompatibilität mit NI Circuit Design Suite 10.0.x

• Neue Schriftartdarstellung in NI Ultiboard
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ActiveX-API in Multisim
Die ActiveX-API in NI Multisim ermöglicht eine automatisierte Simula-
tion und Analyse über eine COM-Schnittstelle. Dies ist dann sinnvoll, 
wenn mehrere Simulationsläufe mit unterschiedlichen Schaltungen erfor-
derlich sind, wie z. B. bei der Bauelement-, Belastungs- oder 
Fehleranalyse. 

Die ActiveX-API ermöglicht die programmatische Steuerung einer 
Multisim-Simulation, ohne dass dazu eine Multisim-Ansicht zwingend 
notwendig wäre. Clients, die mit einer COM-fähigen Programmiersprache 
wie NI LabVIEW, Visual Basic oder C++ erstellt wurden, können über 
diese Schnittstelle auf Multisim zugreifen. 

Mittels der API können Sie:

• Eine vorhandene Schaltung öffnen und schließen

• Anstelle einer bestehenden Spannungs- oder Stromquelle ein Signal 
einspeisen

• Simulationen starten/stoppen/unterbrechen

• Simulationsergebnisse eines statischen Tastkopfs abfragen

• Die einzelnen Bauelemente in der Schaltung benennen

• Bauelemente durch solche aus der Datenbank ersetzen

• Werte für Widerstände, Kondensatoren und Spulen abfragen und 
festlegen

• Varianten durchnummerieren

• Die aktive Variante ermitteln und für Simulationen auswählen

• Schaltungsberichte einschließlich Stückliste und Netzlistenbericht 
erstellen

• Eine Abbildung der Schaltung erstellen
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Hinweise: 

• Die Simulationseinstellungen während API-gesteuerter Simulationen 
stammen von den Einstellungen der Transientenanalyse der ausge-
wählten Schaltung. Änderungen an den interaktiven Simulations-
einstellungen bleiben unberücksichtigt. 

• Die API-Funktion kann nur Bauelemente auf der oberen Ebene eines 
Entwurfs verändern und ersetzen; Bauelemente in Teilschaltungen und 
hierarchischen Schaltungsblöcken können nicht modifiziert werden. 

• Multisim-Austauschbauelemente führen unter Umständen nicht 
immer zum gewünschten Ergebnis – diese sollten deshalb stets in einer 
interaktiven Multisimsitzung getestet werden, um sicherzustellen, dass 
das Verhalten den Erwartungen entspricht.  

• Fehlerhafte Multisim-Einstellungen können nicht über API verändert 
werden. Die Fehleranalyse erfordert die Erstellung von Schaltungen 
mit zusätzlichen Widerstandselementen, und dass die Elemente auf 
Null oder auf große Werte gesetzt werden. 

NI ELVIS II (virtuell)
NI Multisim 10.1 umfasst neue Funktionen und ergänzt auf diese Weise die 
Einführung von NI ELVIS II. NI ELVIS II (virtuell) baut auf dem 
Funktionsumfang von NI ELVIS (virtuell) auf, das bereits Teil früherer 
Software-Releases gewesen ist. Die Funktionen von NI ELVIS II werden 
in Multisim nach der Installation von NI ELVISmx 4.0 aktiviert. Sie haben 
nun die Möglichkeit, entweder mit einer neuen NI-ELVIS- oder einer 
NI-ELVIS-II-Schaltung zu beginnen. Die jeweils ausgewählte Schaltungs-
vorlage bestimmt, welches der 3D-Modelle in der Versuchsanordnung 
verwendet wird. Um eine NI-ELVIS-II-Vorlage auszuwählen, wählen Sie 
Datei»Neu»NI ELVIS II. 

Neben den neuen Schaltungsvorlagen und dem neuen 3D-Modell nutzt 
NI Multisim nun auch die in Multisim verfügbaren Soft Front Panels (SFP) 
von NI ELVISmx 4.0. 

Bitte beachten Sie, dass sich NI ELVIS II auf die Version der Hardware 
und NI ELVISmx 4.0 auf die Version der Software bezieht. 

Hinweis Um alle Vorzüge der Einbindung von NI ELVIS II in Multisim nutzen zu können, 
müssen Sie außerdem noch die Software NI ELVISmx 4.0 installieren. 
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Instrumente von NI ELVIS
In den bisherigen Versionen wurden die Multisim-Instrumente dazu ver-
wendet, die Messverfahren nachzuahmen, die mit NI ELVIS in der realen 
Welt durchgeführt werden. Daher wurden die Soft-Frontpanels (SFPs) von 
NI ELVIS II in Multisim eingebunden, die auch mit der Hardware zum 
Einsatz kommen. Diese Instrumente erlauben es, sowohl simulierte als 
auch real erfasste Daten auf demselben Display anzuzeigen. 

Die Soft-Frontpanels von NI ELVIS II können auf zweierlei Weise aufge-
rufen werden: Entweder Sie greifen über die Leisten oder die Oberseite 
einer Schaltungsvorlage von NI ELVIS II darauf zu, oder Sie ziehen sie mit 
Hilfe der Symbolleiste für NI-ELVIS-Instrumente in eine 
Multisim-Schaltung.

Einschränkungen von NI ELVIS II in Multisim 10.1
Multisim 10.1 unterstützt nicht alle Soft-Frontpanels von NI ELVIS 4.0. 
Instrumente, die Frequenzganginformationen liefern, wie z.B. der 
Bode-Analysator, und solche, die Impedanz und Stromstärke messen, 
werden nicht unterstützt. 

Verbesserungen von LabVIEW-Instrumenten in NI Multisim
Mit Hilfe von LabVIEW können Sie Instrumente zur Eingabe und/oder 
Ausgabe nach eigenen Vorstellungen erstellen und in Multisim einbinden. 
Zu den Verbesserungen in Multisim 10.1 gehören die Unterstützung von 
Eingabe- und Ausgabe-Anschlussstiften am selben Instrument, die fortlau-
fende Datenübertragung an Multisim von Ausgabeinstrumenten, sowie die 
Fähigkeit, mit Hilfe von Eingabeinstrumenten auf die in der Simulation 
verwendeten Zeitschritt- und Interpolationsverfahren Einfluss zu nehmen.

Eingabe- und Ausgabeinstrumente
In früheren Versionen konnten entweder nur Ein- oder nur Ausgabeinstru-
mente genutzt werden. Nun können Instrumente mit zwei Datenrichtungen 
genutzt werden, ohne dass diese den bisherigen im Funktionsumfang nach-
stehen. Beachten Sie jedoch, dass bei der Erfassung die Daten erst vom 
Simulator erzeugt und dann paketweise an LabVIEW-Instrumente übertra-
gen werden. Analog werden Ausgangsdaten zunächst vom Simulator 
angefordert, bevor das Instrument paketweise mit der Übertragung beginnt. 
Aufgrund dieser Verzögerung können keine Rückkopplungsschleifen 
erzeugt werden, bei denen die Ausgangswerte sofort wieder am Eingang 
zur Verfügung stehen müssen. Meist benötigt das Instrument mindestens 
eine zusätzliche Iteration des Ereignisses “Update Data Get Output 
Values”, bevor am Eingang des Instruments mit Sicherheit der neueste 
Ausgangswert anliegt. 
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Fortlaufende Daten von Ausgabeinstrumenten
Bisher war es so, dass Ausgabeinstrumente nur eine bestimmte Menge von 
Daten (ggf. wiederholt) erzeugen konnten. Bei der Erstellung eines Ausga-
beinstruments, das Daten fortlaufend generiert, muss stets bedacht werden, 
dass Multisim Schaltungen im Allgemeinen langsamer simuliert als eine 
reale Schaltung. Falls Sie also ein Instrument erstellen, dass kontinuierlich 
reale Daten mit Hilfe einer Datenerfassungsvorrichtung, einem modularen 
Instrument oder ähnlicher Hardware erfasst, um diese Daten als Simulati-
onsquelle in Multisim zu verwenden, so ist die Simulation nicht in der 
Lage, mit den erfassten Daten Schritt zu halten, da die Simulation langsa-
mer abläuft als die Datenerfassung. 

Es obliegt also dem Entwickler des Ausgabeinstruments, die Datenpakete 
entsprechend klein zu halten und in einer Geschwindigkeit zu übertragen, 
bei der die Multisim-Simulation mit dem Tempo der Datenerfassung 
Schritt halten kann.

Einflussnahme auf das Zeitschritt- und 
Interpolationsverfahren
LabVIEW erfasst und verarbeitet Daten in gleichmäßigen Zeitschritten. 
SPICE arbeitet im Allgemeinen in ungleichmäßigen Zeitschritten, die der 
Konvergenz und der Geschwindigkeit gut angepasst sind. Bei der Erstel-
lung eines Eingabeinstruments ist es notwendig, die Daten vor der 
Verwendung in LabVIEW erneut abzutasten, um gleichmäßig angeordnete 
Daten zu erhalten. Jetzt können Sie auch Instrumente erstellen, die von der 
Force-Step-Interpolationsfunktion Gebrauch machen. (Force Step ist 
streng genommen kein Interpolationsverfahren. Es zwingt den Multisim-
SPICE-Simulator zu zusätzlichen Zeitschritten, die sich in die vorgesehene 
Abtastfrequenz eingliedern.)  

Falls ein bestimmtes LabVIEW-Instrument die Einstellung der Abtastfre-
quenz und/oder des Interpolationsverfahren ermöglicht, erkennt Multisim 
10.1 während der Simulation auftretende Veränderungen dieser Werte. 

Verbesserte und umfangreichere Bauelemente-Datenbank
An der Bauelemente-Datenbank von Multisim 10.1 wurden zahlreiche 
Ergänzungen und Verbesserungen vorgenommen. Dazu gehören etwa 300 
neue Bauelemente führender Hersteller, mehr als 500 aktualisierte Bauele-
mente sowie generische Bauteile zur Simulation von Stromversorgungen 
neuester Generation. 
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Neue Bauelemente führender Hersteller
Etwa 300 neue Bauelemente mit Modellen der Unternehmen Analog 
Devices und Texas Instruments sind verfügbar. Dazu gehören entspre-
chende Symbole, Modelle und Land-Pattern nach IPC-Standard. Zu den 
Bauelementen gehören Operationsverstärker, Komparatoren, Analogschal-
ter und Vergleichsspannungsquellen.

Generische Bauteile zur Simulation von 
Stromversorgungen
Multisim 10.1 enthält Modelle für alle frei verfügbaren Bauteile zur Simu-
lation von Stromversorgungen, die aus der zuletzt erschienenen Ausgabe 
der “Switch-Mode Power Supply SPICE Simulations and Practical 
Designs” von Christophe Basso hervorgehen. Zu diesen Bauelementen 
gehören Aufwärts-, Abwärts-, Aufwärts-/Abwärts sowie 
PWM-Steuerelemente.

Erweiterte Fähigkeiten zur SPICE-Modellierung
Bei Multisim 10.1 gibt es außerdem Verbesserungen an der SPICE-Model-
lierungsfunktion. Der SPICE-Parser wurde umgestaltet und verbessert, um 
mehrere SPICE-Sprachen und die erweiterte Modellierung besser unter-
stützen zu können. Multisim unterstützt nun auch weitere Cadence®-
PSpice®-Parameter. Auch die XSPICE-Modell-Fehlermeldung wurde 
verbessert.

Neugestaltung und Verbesserung des NI Multisim 
SPICE-Parser
Der SPICE-Parser in Multisim interpretiert die nativen SPICE-Netzlisten, 
meldet Syntaxfehler und bewertet mathematische Ausdrücke. Zu den Ver-
besserungen des Parsers gehören:

• Verbesserte Syntax und Simulationskompatibilität für geregelte 
Quellen.

• Quelltabellen.

• Eine Vielzahl an Kompatibilitätsverbesserungen erweitern die Fähig-
keit zur Unterstützung der Cadence®-PSpice®- und Intusoft 
IsSpice4™-Syntax.

• Flexible Bezeichnungen für Bauelemente, Netze, Anschlüsse und 
Modelle.

– Die Bezeichnungen können außer Leerstellen beliebige Zeichen 
enthalten, mit Ausnahme der folgenden: " ' ( ) { } [ ] , # 
$: ;
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• Die Möglichkeit, Ausdrücke anstelle beliebiger Werte in der Netzliste 
zu verwenden.

– Zwei spezielle Ausnahmen bilden hierbei der BSIM-Ebe-
nen-Parameter und die POLY-Nummer in einer geregelten Quelle. 

• Verbesserte Unterstützung für Ausdrücke, einschließlich:

– Unterstützung von Inline-if-Befehlen.

– Verbesserte Unterstützung für .param-Befehle.

– Volle Unterstützung von einzelnen und verschachtelten 
.func-Befehlen.

– Strom, der durch Dioden und relevante geregelte Quellen fließt, 
kann nun in Ausdrücken (für nicht eindeutige Quellen) verwendet 
werden.

– Verbesserte Fähigkeit zum Ermitteln einer stabilen Lösung für 
komplexe Verhaltenssimulationsschaltungen.

Verbesserte SPICE-Modell-Fehlermeldung
Fehlermeldungen, die sich auf SPICE-Modelle beziehen, sind nun aussage-
kräftiger als zuvor. 

Bauelementanschlüsse, Parameter und Ausdrücke werden nun eingehend 
überprüft, bevor die Simulation beginnt. Simulationsfehler werden auf der 
Registerkarte “Simulation” in der Tabellen-Ansicht angezeigt und identifi-
zieren genau die Multisim-Bauelemente, welche die Probleme 
verursachen. 

Hinweis Mit Ausnahme der Registerkarten “Simulation” und “Ergebnisse” ist die Tabel-
len-Ansicht in der Student Edition von Multisim nicht verfügbar. Um weitere 
Informationen zu diesen Registerkarten zu erhalten, sehen Sie sich bitte die Multisim-
Hilfedatei an. 
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Verbesserungen der 
Cadence®-PSpice®-Kompatibilität
Multisim 10.1 unterstützt ab sofort die folgenden Cadence®-PSpice®-Para-
meter für MOSFETS und BJTs: 

NI Update Service
Der neue NI Update Service hilft Ihnen dabei, Ihre Software von National 
Instruments und die dazugehörigen Treiber auf dem neuesten Stand zu hal-
ten. Der NI Update Service ersetzt das Support and Upgrade Utility (SUU), 
führt eine Suche nach Updates für Ihre Software von National Instruments 
durch und lädt diese herunter. Mit dem Programm können Sie jederzeit 
feststellen, ob Sie mit der neuesten Version Ihrer Software arbeiten. 

Windows-Vista-Tauglichkeit
NI Circuit Design 10.1 ist für Windows geeignet. Die Version 10.0.1 war 
bereits für Vista geeignet, hat jedoch während der Laufzeit Einträge in das 
Programmdateiverzeichnis vorgenommen. Multisim 10.1 erfüllt die Richt-
linien zur Vista-Kompatibilität.

Bessere Speicherung benutzerspezifischer Felder 
aus der Hauptdatenbank
Benutzerspezifische Felder, die mit in der Hauptdatenbank gespeicherten 
Bauelementen zusammenhängen, werden nun separat abgelegt. Bei der 
Arbeit bzw. Bearbeitung mit/von benutzerspezifischen Feldern in Multisim 
werden Sie keinen sichtbaren Unterschied feststellen können. Auf diese 
Weise bleiben jedoch die Daten von Version zu Version erhalten. Dies ist 
auch eine Voraussetzung für Vista-Kompatibilität.

Parameter Beschreibung Bauteil

m Geräte-Mehrfachparameter MOSFET

Rg, Rb Gatter- und Substratwiderstand 
(Ohmscher Widerstand)

MOSFET

Rds Drain-Source 
Nebenschlusswiderstand

MOSFET

W, L Unterstützung von Breite (W) und 
Länge (L) an Zeile .model

MOSFET

Nk Kniestrom Roll-off-Koeffizient BJT
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Unterstützung von TDMS-Dateien
Multisim unterstützt nun TDMS-Dateien. TDM-Spannungs- und Strom-
quellen können auf TDM-Streaming-Dateien verweisen und das 
Multisim-Diagrammfenster ist in der Lage, TDMS-Daten zu exportieren.

Dateikompatibilität mit NI Circuit Design Suite 10.0.x
Dateien der NI Circuit Design Suite 10.0.x und 10.1 sind rückwärts- und 
vorwärtskompatibel. Dateierweiterungen bleiben unverändert; Dateien 
lassen sich mit beiden Versionen öffnen, egal mit welcher Version sie 
abgespeichert wurden.

Neue Schriftartdarstellung in NI Ultiboard
Schriftarten auf Leiterplattenlagen in Ultiboard werden nun mit Hilfe der 
Anti-Grain-Geometry abgebildet. Dadurch werden Schriftarten schneller 
dargestellt und auch die Kantenglättung (Antialiasing) wird verbessert. 

Lokalisierte Versionen
Die NI Circuit Design Suite 10.1 gibt es in übersetzter Fassung auf 
Deutsch, Englisch und Japanisch. Je nach Regionaleinstellung verwendet 
die Software die voreingestellte Sprache. 

Zum Ändern der Sprache des Programms wählen Sie Optionen»Allge-
meine Einstellungen, klicken auf die Registerkarte Allgemein, wählen die 
gewünschte Sprache aus dem Feld Spracheinstellungen aus und starten 
die Anwendung neu. 

Die folgenden Programmkomponenten liegen nur auf Englisch vor: 

• LabVIEW-Instrumente.

• NI ELVIS-Instrumente.

• Lagennamen in der Spreadsheet-Ansicht von NI Ultiboard und 
NI Multisim.

• Simulierte Messgeräte von Agilent und Tektronix.

• Beispieldateien.

• MCU-Funktionen: Namen von Quelldateien, Code/Kommentare in 
Quelldateien und Compiler-/Linker-Meldungen.

Die folgende Dokumentation ist auch auf Englisch, Deutsch und Japanisch 
erhältlich:

• Versionshinweise.

• Erste Schritte mit der NI Circuit Design Suite.

Benutzerhandbücher und Hilfedateien liegen nur auf Englisch vor. 
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Einzelheiten zu dieser Version
Im Folgenden werden alle Funktionen zur Erstellung von Schaltplänen auf-
geführt, die in der Studenten- und Schulungsversion von Multisim 
verfügbar sind:

Funktion Studentenversion Schulungsversion

Konfigurierbare Bedienoberfläche X X

Screenshot-Funktion X X

Kommentarfelder im Schaltplan X X

Notizen zum Schaltplan X X

Bauteilplatzierung und -verdrahtung mit 
automatischer Modusumschaltung

X X

Schneller Zugriff auf Bauelemente in den 
Werkzeugleisten

X X

Automatische und manuelle Verdrahtung X X

Virtuelle Verdrahtung per Knotennamen X X

Automatische Verbindungsanpassung beim 
Verschieben von Bauelementen

X X

Schnelle automatische Verbindung passiver 
Bauelemente

X X

Teilschaltpläne X X

Dreidimensionale Versuchsanordnung X X

NI ELVIS I und II (virtuell) X X

Integrierte Fragen ansehen und beantworten X X

Übertragung der Beschriftung mit Ultiboard in 
beide Richtungen

X X

Gleichzeitige Hervorhebung in Schaltplan und 
Layout mit Ultiboard

X X

Bus-Vektorverbindungen X

Ansicht als Tabellenkalkulationsdokument X

Entwurfseinschränkungen X

Erweiterte Suche X



© National Instruments Corporation 13 Versionshinweise zur NI Circuit Design Suite 

Im Folgenden werden alle Simulationsfunktionen in der Lern- und Schu-
lungsversion von Multisim beschrieben:

Markierten Bereich heranzoomen X

Firmenbibliotheksdatenbank X

Benutzerdefinierte Felder X

Bauelemente vom Arbeitsbereich in Datenbank 
speichern

X

Mehrere Schaltungen geöffnet X

Integrierte Fragen erstellen und bearbeiten X

Prüfung auf Einhaltung der elektrischen 
Schaltungsregeln

X

Markierung freier Anschlussstifte X

Hierarchische Schaltungsentwicklung X

Schaltpläne auf mehreren Arbeitsblättern X

Projektmanager X

Berichte einschließlich Stückliste X

Tausch von Anschlussstift und Gatter X

Export als Mentor-PADS-Layout X

Gerätebibliothek Teilweise Vollständig

Höchstanzahl der Bauteile in einer Schaltung 50 Unbegrenzt

Funktion Studentenversion Schulungsversion

Interaktive Simulation X X

Kombinierte Simulation analoger und digitaler 
Bauelemente

X X

Standardmäßiges SPICE 3X5/XSPICE X X

Erweiterte Modellunterstützung X X

Cadence®-Pspice®-Modellsimulation* X X

Einstellen von Geschwindigkeit und Genauigkeit X X

Simulation Advisor X X

Funktion Studentenversion Schulungsversion
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Assistent zur automatischen Korrektur von 
SPICE-Simulationsfehlern

X X

Virtuelle, interaktive und animierte Bauelemente X X

Bedienung von Bauelementen per Mausklick X X

Bauelemente mit bestimmbarer Höchstbelastung X X

Einbauen von Fehlern in Bauelemente X X

Mess-Tastköpfe X X

Bauelement-Assistent X X

Arbeit mit National-Instruments-Dateiformaten für 
Messwerte

X X

Export in National-Instruments-Dateiformate für 
Messwerte

X X

NI-LabVIEW-VIs als Messgeräte und Quellen X X

Mikrofon und Lautsprecher X X

Schaltungseinschränkungen X X

Diagrammanzeige und Postprozessor X X

RF-Modul X X

Schaltungsassistenten X

Modellierung in C X

Dynamisch wechselnde Beschreibung zur 
Simulation

X

Kontaktpläne/Kontakte X

Modellgeneratoren X

Laden und Speichern von Simulationsprofilen X

Virtuelle Messinstrumente 22 22

Analysen 10 18

Multisim-MCU X X

ActiveX-API in Multisim X

* Unterstützt nicht jede Cadence®-PSpice®-Syntax

Funktion Studentenversion Schulungsversion
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Im Folgenden werden alle Layoutfunktionen in den Studenten- und Schu-
lungsversionen von Ultiboard aufgeführt:

Funktion Studentenversion Schulungsversion

Leiterbahnplatzierung durch “Push & Shove” X X

Bauteilplatzierung durch “Push & Shove” X X

Echtzeitfunktionen und Funktion “From Copper 
Ratsnest” 

X X

Laufende Anpassung von Polygonen mit Anordnung 
kupferloser Flächen

X X

Weitergabe von Schaltplan- und Bauteilnotizen X X

Gleichzeitige Hervorhebung in Schaltplan und 
Layout mit Multisim

X X

Laufendes Prüfen auf Einhaltung der Entwurfsregeln X X

64 Lagen und Auflösung von 1 nm X X

Leistungsfähiger Footprint-Assistent X X

Erweiterte 3D-Visualisierung mit Druckfunktion X X

Anwenderkommentare X X

Vollbildschirmdarstellung X

Ausgabe der Daten im Gerber-, DXF-, IPC-D-356A- 
und SVG-Format

X

Abmessungen von Leiterplatte und Footprint X

Abmessungen im Datenbank-Manager X

Netzanknüpfungspunkte X

3D-Visualisierung innerhalb der Leiterplatte X

Ausschalten der Ratsnest-Funktion für ausgewählte 
Netze

X

Rasterlose Follow-Me-Leiterbahnplatzierung X

Laden und Speichern von Technologiedateien X

Polarnetze X

Kundenspezifische Lagenansicht X

Aufgeteilte Speisungsschichten X
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Freizuhaltende Platinenbereiche X

Gruppenweise Platzierung von Bauelementen X

Entfernen aller platzierten Bauelemente X

Linealausrichtung und -messungen X

Automatisches Ausrichten X

Speichern von Platinenentwürfen als Bauelement X

Dauerhafte Gruppierung X

Austauschen von Anschlussstiften und Gattern X

Multiple Freiräume X

Springen zu fehlerhaften Stellen X

Leiterbahnplatzierung mit einheitlichem Abstand X

Rechner für differentielle Impedanz X

Rechner für Übertragungsleitung X

Mikrovias X

Einfügen von Testpunkten X

Automatisches Generieren tränenförmiger 
Verstärkungen zwischen Lötaugen und Leiterbahnen

X

Unterstützung von Leiterbahnen mit abgeknickten 
Segmenten zu Anschlussstiften

X

Automatisches Einsetzen von Steckbrücken X

Funktionen “Route kopieren” und “Platzierung 
wiederholen”

X

Footprints auf Platine editierbar X

CAD-Funktionen zur Entwicklung mechanischer 
Elemente

X

Export von 3D-Info in 3D IGES, DXF-Formate X

Berechnung des Kupferbedarfs X

Testpunktbericht X

Kundenspezifische Berichterstellung X

Funktion Studentenversion Schulungsversion
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Im Folgenden werden alle Funktionen zur automatischen Leiterbahnfüh-
rung in der Studenten- und Schulungsversion von Ultiboard aufgeführt:

Mehrere geöffnete Dokumente X

Mögliche Anzahl von Anschlussstiften 350 1000

Ansicht als Tabellenkalkulationsdokument Begrenzt Vollständig

Funktion Studentenversion Schulungsversion

Voll konfigurierbare Kostenberechnung X X

Progressive Leiterbahnführung X X

Interaktive automatische Leiterbahnführung X X

Leiterbahnführung unter Berücksichtigung von 
Entwurfsregeln 

X X

Manuelles Vorplatzieren: Bauelemente, 
Durchkontaktierungen, Leiterbahnen

X X

Automatische Erkennung von Blockkondensatoren X X

Spiegeln von oberflächenmontierbaren 
Bauelementen 

X X

“Gummiband”-Leiterbahnen X X

Folgt den Kriterien der belegbaren/freizuhaltenden 
Bereiche

X X

Maximale Anzahl von Anschlussstiften 350 1000

Maximale Anzahl von Lagen 2 4

Funktion Studentenversion Schulungsversion
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Dokumentation
Zur NI Circuit Design Suite 10.1 gehört eine umfassende Dokumentation.

Die folgenden Dokumente sind in gedruckter und in elektronischer Form 
verfügbar:

• Erste Schritte mit der NI Circuit Design Suite.

• Versionshinweise zur NI Circuit Design Suite.

Die folgenden Dokumente liegen elektronisch als PDF-Dateien vor:

• Benutzerhandbuch zu Multisim.

• Benutzerhandbuch zur Multisim-Schulungsversion.

• Benutzerhandbuch zu Ultiboard.

Hinweis Da das Multisim-MCU-Modul nun in NI Multisim enthalten ist, wurde die Nut-
zeranleitung zum Multisim-MCU-Modul nicht weitergeführt. Weitere Einzelheiten zu 
Multisim MCU finden Sie im Benutzerhandbuch zu Multisim. Auch das Bauelemente-
handbuch zu Multisim wurde nicht weiter ergänzt. Um weitere Informationen zu 
Bauelementen zu erhalten, sehen Sie sich bitte die Bauelement-Referenzhilfedatei an. 

Zum Öffnen der Handbücher wählen Sie unter Start»Alle Programme»
National Instruments»Circuit Design Suite 10.1»Dokumentation die 
gewünschte Datei aus. 

Die folgenden Hilfedateien können entweder über das Hilfemenü der Soft-
ware oder das Start-Menü von Windows geöffnet werden: 

• Hilfe zur Schulungsversion von Multisim.

• Hilfedatei zu Ultiboard.

Zum Öffnen der Hilfedateien wählen Sie unter Start»Alle Programme»
National Instruments»Circuit Design Suite 10.1»Dokumentation die 
gewünschte Datei aus. 

Die folgenden Hilfedateien sind über das Hilfemenü in der Software 
verfügbar: 

• Bauelemente-Übersicht der Schulungsversion.

• Symboleditor-Hilfe von Multisim (Zugriff über Symboleditor).

• Titelblockeditor-Hilfe von Multisim (Zugriff über Titelblockeditor). 
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NI Circuit Design Suite
バージョン 10.1

これらのリリースノートには、NI Circuit Design Suite 10.1 のシステム

要件、製品層に関する情報、新規機能、ドキュメントリソース、

NI Multisim 10.0.1 および NI Ultiboard 10.0.1 以降のその他の変更が記載

されています。 

NI Circuit Design Suite には、National Instruments Electronics 
Workbench Group のソフトウェア製品である NI Multisim および

NI Ultiboard が含まれています。 NI Multisim MCU モジュールの機能は、

NI Multisim に追加されました。 
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NI Circuit Design Suite 10.1 をインストールする

このセクションでは、NI Circuit Design Suite のシステム要件およびイン

ストール方法について説明します。 

最小システム要件
ナショナルインスツルメンツでは、NI Circuit Design Suite 10.1 を実行

するシステムが以下の要件を満たしていることを推奨します。 

• Windows 2000 Service Pack 3 以降、Windows XP、Vista、または

64 ビット版 Vista。

• Pentium 4 クラスのマイクロプロセッサまたは同等（Pentium III ク
ラス以上）。

• 512 MB のメモリ推奨（最小 256 MB）。 

• 1.5 GB のハードディスク空き容量（最小 1 GB）。

• OpenGL® 対応の 3D グラフィックカード推奨（最小 800 × 600 ビデ

オ分解能の SVGA 分解能ビデオアダプタ、1024 × 768 以上推奨）

• Multisim で使用する LabVIEW ベースのカスタム計測器を作成する

場合は、LabVIEW 8.2.xまたは 8.5.xが必要です。 

インストールの手順
NI Circuit Design Suite 10.1 のインストーラは、パッケージ内の製品す

べて（Multisim および Ultiboard）をインストールします。 

ナショナルインスツルメンツは、NI Circuit Design Suite をインストール

する前に開いているすべてのアプリケーションを閉じることを推奨しま

す。
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インストール中に別の場所を指定しない限り、NI Circuit Design Suite の

インストールプログラムは、<Program Files>¥National 

Instruments¥Circuit Design Suite 10.1にファイルをコピーしま

す。

1. NI Circuit Design Suite の CD を CD-ROM ドライブに挿入します。 
CD の起動画面が表示されない場合は、Windows のスタート

メニューから実行を選択して、CD ドライブから setup.exeを実行

します。 

2. ダイアログボックスの手順に従います。 

メモ NI Circuit Design Suite (NI CDS) 10.1 のインストールが完了したら、NI CDS
パッケージに付属する NI ELVISmx 4.0 インストール CD についてのメッセージ

がインストーラにより表示されます。 NI ELVISmx 4.0 は、Multisim で NI ELVIS II
の機能を有効にします。 NI ELVISmx 4.0 ソフトウェアをインストールする場合

は、表示されるメッセージに従ってください。 または、NI ELVISmx 4.0 ソフト

ウェアを後でインストールすることもできます。 詳細については、

「仮想 NI ELVIS II」および「NI ELVIS 計測器」セクションを参照してください。 

製品のアクティブ化
NI Circuit Design Suite の製品を最初に実行すると、製品のライセンスの

アクティブ化を求められます。 

有効なライセンスをアクティブ化しない場合、製品は評価モードで実行さ

れ、その後製品を実行すると毎回ライセンスのアクティブ化が要求され

ます。 評価モードは、製品を最初に実行した日から 30 日間有効です。

ソフトウェア製品のアクティブ化の手順についての詳細は、NI Circuit 
Design Suite 10.1 付属の『Activation Instructions for National 
Instruments Software』を参照してください。 

NI Circuit Design Suite 10.1 の新規機能

このドキュメントでは、NI Circuit Design Suite 10.1 の以下の追加また

は改善点について説明します。

• Multisim オートメーション API。

• 仮想 NI ELVIS II。

• NI ELVIS 計測器。

• Multisim における NI LabVIEW 計測器の改善。

• コンポーネントデースへの追加。

• 強化された SPICE モデリング機能。

• NI 更新サービス。

• Vista 対応。

• TDMS データファイルのサポート。
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• NI Circuit Design Suite 10.0.xとのファイル互換性。

• 仮想 NI ELVIS II。 

• NI Ultiboard における新規フォントレンダリング。

NI Multisim オートメーション API
NI Multisim オートメーション API では、COM インタフェースを介した

シミュレーションおよび解析の自動化が可能です。 これは、異なる回路設

定でシミュレーションの実行が何度も必要な場合に役立ちます。 コンポー

ネント解析、応力解析、および故障解析などがそのようなタスクの例で

す。 

Multisim オートメーション API では、Multisim を表示せずに Multisim
のシミュレーションをプログラムで制御することが可能です。 
NI LabVIEW、Visual Basic、または C++ などの COM 対応プログラミ

ング言語で作成されたクライアントで、このインタフェースを介して

Multisim にアクセスすることができます。 

API を介して以下を実行できます。

• 既存回路を開閉。

• 既存の電圧または電流ソースの位置に信号を挿入（オプション）。

• シミュレーションを開始、停止、および一時停止。

• 既存のスタティックプローブから結果を読み取る。

• 回路図でコンポーネントを列挙。

• コンポーネントをデータベースからのコンポーネントと置換。

• 抵抗器、キャパシタ、およびインダクタコンポーネント値を取得およ

び設定。

• バリアントを列挙。

• シミュレーションのアクティブバリアントを取得および設定。

• 材料表およびネットリストレポートを含むレポートを回路図で生成。

• 回路の画像を生成。

メモ : 

• API 制御シミュレーション中に使用されるシミュレーション設定は、

選択した回路の「過渡解析」設定から取得されます。 「対話式シミュ

レーション」設定の変更はすべて無視されます。 

• API では、設計のトップレベルのコンポーネントのみの変更および置

換が可能で、サブ回路および階層ブロックのコンポーネントは変更で

きません。 
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• Multisim コンポーネントの置換では、予測どおりの結果にならない

場合があります。Multisim の対話式セッションでテストし、予測通

りに動作することを常に確認する必要があります。  

• Multisim の「故障」設定は、API を介して変更することができませ

ん。 故障解析では、追加の抵抗素子が含まれる回路の作成し、素子を

ゼロまたは大きな値に設定する必要があります。 

仮想 NI ELVIS II
NI Multisim 10.1 には、NI ELVIS II に同等する新規機能が含まれています。 
仮想 NI ELVIS II は、以前のバージョンのソフトウェアに搭載されていた仮

想 NI ELVIS の機能上に構築されています。 NI ELVIS II の機能は、

NI ELVISmx 4.0 ソフトウェアをインストールした後に Multisim でアク

ティブ化されます。 新規 NI ELVIS または NI ELVIS II 回路図のいずれかで開

始することを選択できます。 回路図テンプレートの選択は、ブレッドボー

ドモードで使用される 3D NI ELVIS モデルの決定に影響を与えます。 
ファイル→新規→ NI ELVIS II を選択して、NI ELVIS II テンプレートを選択

します。 

NI Multisim は、新規回路図および新規 3D モデルの他に、

NI ELVISmx 4.0 ソフトフロントパネル（SFP）を Multisim の内部で使用

します。 

NI ELVIS II はハードウェアのリビジョン番号、NI ELVISmx 4.0 はソフト

ウェアのリビジョンを指します。 

メモ NI ELVIS II および Multisim が統合された利点を最大限に活用するには、

NI ELVISmx 4.0 ソフトウェアをインストールする必要があります。 

NI ELVIS 計測器
以前のリリースでは、Multisim のネイティブ計測器は、NI ELVIS で実際

に実行される測定タイプを複製するために使用されました。 NI Multisim
では、計測器ハードウェアと使用される NI ELVIS II ソフトフロントパネル

（SFP）が使用されるようになりました。 これらの計測器では、シミュレー

ションまたは実際の測定による両データを同じディスプレイに表示するこ

とが可能です。 

NI ELVIS II SFP は、NI ELVIS II 回路図テンプレートのレールまたは上部か

らアクセス、または NI ELVIS 計測器ツールバーから Multisim 回路図にド

ロップする 2 通りの方法で呼び出すことができます。
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Multisim 10.1 における NI ELVIS II の制限
Multisim のバージョン 10.1 のリリースでは、一部の NI ELVIS 4.0 SFP が

サポートされていません。  ボーデアナライザなどの周波数応答情報を提供

する計測器、そしてインピーダンスおよび電流測定を提供する計測器はサ

ポートされていません。 

NI Multisim における NI LabVIEW 計測器の改善
Multisim の LabVIEW 計測器では、Multisim で使用するためのカスタム

入力、出力、および入力 / 出力計測器を作成することができます。 
Multisim 10.1 での改善点には、同じ計測器での入力および出力の両ピン

のサポート、出力計測器から Multisim への連続データ出力、およびシ

ミュレーションで使用する時間ステップおよび補間法に作用する入力計測

器の機能が含まれてます。

入力および出力計測器
以前のリリースでは、入力および出力専用の計測器のみが利用可能でし

た。 入力 / 出力計測器には、入力または出力専用計測器の機能もすべて含

まれています。 ただし、LabVIEW 計測器の入力データは遅延し（シミュ

レータによるデータの生成後、計測器で個別のセットで受信される）、

ストリーミング出力データは先行します（シミュレータが必要になる前に

データを個別のセットで要求する）。 これは、LabVIEW 計測器の出力が瞬

時に入力に依存する厳密なフィードバックループが可能ではないというこ

とを指します。 通常、計測器が受信した入力が調整された出力信号に反映

される前に、計測器の「Update Data Get Output Values」イベントを

介する連続出力が 1 セット以上が必要になります。 

出力計測器からの連続データ
以前は、データ出力計測器で繰り返すデータの有限セットを生成すること

ができました。 Multisim では、データを連続生成する出力計測器を作成す

る場合、同等の物理回路の実際の動作よりも遅いレートで回路がシミュ

レートされることに注意してください。 そのため、データ集録デバイス、

モジュール式計測器、またはその他の同様のハードウェアを使用して実際

のデータを連続集録する計測器を作成する際に、そのデータを Multisim
でシミュレーションソースをして使用すると、シミュレーションはデータ

集録よりも遅いレートで実行されるため、集録したデータを維持すること

ができなくなります。 

Multisim のシミュレーションでデータ集録を維持できるレートで、十分

に小さなデータセットを生成する出力計測器を作成する必要があります。
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時間ステップおよび補間法への影響
LabVIEW は、偶数の時間ステップでデータをサンプルおよび処理します。 
SPICE は通常、収束および速度に最適な不規則な時間ステップで動作し

ます。 LabVIEW で使用するには、入力計測器を作成する際にデータを再

サンプルして、データ間隔を均一にする必要があります。 「強制ステップ」

補間を使用する計測器を作成できるようになりました。 （「強制ステップ」

は、厳密には補間法ではありません。 Multisim SPICE シミュレータが、

要求されたサンプルレートに一致する追加の時間ステップを取得すること

を強制します）。  

特定の LabVIEW 計測器でサンプルレートまたは補間法の設定が可能な場

合、Multisim 10.1 はシミュレーション中にこれらの値の変更を認識し

ます。 

向上したコンポーネントデータベースの品質および幅
Multisim 10.1 のデータベースには、いくつかの追加および改善点があり

ます。 約 300 個の主要メーカーの新規コンポーネント、500 個以上の更新

されたコンポーネント、そして最新の汎用電力シミュレーション用部品な

どが追加されました。 

主要メーカーの新規コンポーネント
Analog Devices および Texas Instruments のモデルによる約 300 個の

新規コンポーネントが追加されました。 これらの追加には、シンボル、

モデル、および IPC 標準ランドパターンが含まれています。 これらのコン

ポーネントには、オペアンプ、比較器、アナログスイッチおよび電圧基準

モデルが含まれています。

一般電力シミュレーション部品
NI Multisim 10.1 には、『Switch-Mode Power Supplies Spice 
Simulations and Practical Designs』（Christophe Basso 著）の最新版

に記載されるすべての電力シミュレーションの部品用のモデルが含まれて

います。 これらのコンポーネントには、バック、ブースト、バックブース

ト、および PWM コントローラがあります。

強化された SPICE モデリング機能
Multisim 10.1 では、SPICE モデリング機能が強化されました。 複数の

SPICE 言語および上級モデリングのより優れたサポートを提供するため

に、SPICE パーサは再設計および強化されました。 Multisim はまた、より

多くの Cadence® PSpice® パラメータをサポートしています。 また、

XSPICE モデルエラーレポート機能も強化されました。
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NI Multisim SPICE パーサの再設計および強化
Multisim の SPICE パーサは、ネイティブ SPICE ネットリストの解釈、

構文エラーの報告、そして数式の評価を行います。 パーサの改善点には以

下が含まれます。

• 強化された制御ソースのシミュレーション互換性および構文。

• 表ソース。

• Cadence® PSpice® および Intusoft IsSpice4TM 構文のサポート機能

を強化するために改善された互換性。

• 柔軟なコンポーネント、ネット、端子、およびモデル名。

– 名前には、空白のスペースおよび特定の文字（" ' ( ) { } [ ] 

, # $: ;）以外を含むことができます。

• ネットリストの任意の値で数式を使用する機能。

– 制御ソースの POLY数値および BSIM levelパラメータが 2 つの

例外です。 

• 数式サポートの改善点は以下のとおりです。

– インライン ifステートメントのサポート。

– .paramステートメントのサポートの改善点は以下のとおりで

す。

– 単一およびネスト化 .funcステートメントのフルサポート。

– ダイオードおよび関連制御ソースを介する電流を数式（任意ソー

ス）で使用できるようになりました。

– 複雑な動作モデリング式回路における収束の強化。

SPICE モデルエラーレポート機能の強化
SPICE モデルに関連するエラーのよりインテリジェントなエラーメッ

セージ表示。 

シミュレーションの開始前に、コンポーネント端子、パラメータ、および

数式の詳細なチェックが行われるようになりました。 シミュレーションエ

ラーは「スプレッドシートビュー」の「シミュレーション」タブに表示さ

れ、問題の原因となる Multisim コンポーネントを特定します。 

メモ 「シミュレーション」タブおよび「結果」タブを除いて、「スプレッドシート

ビュー」は学生版では利用できません。 これらのタブの詳細については、

Multisim のヘルプファイルを参照してください。 
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Cadence® PSpice® 互換性の向上
Multisim 10.1 は、以下の Cadence® PSpice® パラメータが MOSFETS
および BJT でサポートされるようになりました。 

NI 更新サービス
新しい NI 更新サービスを使用すると、ナショナルインスツルメンツのソ

フトウェアとドライバを常に最新状態に維持することができます。 NI 更新

サービス（旧 SUU: Support and Upgrade Utility）は、ご使用の NI ソフ

トウェアのソフトウェアの更新をオンライン形式で配布します。 NI 更新

サービスを起動して、更新を確認したり、最後に更新がインストールされ

た日付を判断することができます。 

Windows Vista 対応
NI Circuit Design 10.1 は、Windows に対応しています。 バージョン

10.0.1 は Vista 対応ですが、ランタイム時は「Program Files」ディレク

トリに継続して書き込みを行います。 Multisim 10.1 は、Vista の指針に順

守しています。

マスタデータベースのユーザフィールドストレー
ジの改善
マスタデータベースに格納されるコンポーネントの関連ユーザフィールド

を個別に格納できるようになりました。 Multisim のユーザフィールドの編

集および操作する際に目に見える影響はありません。 ただし、バージョン

間で移行するデータを維持する上で役立ちます。 これは、Vista 対応にお

ける要件の 1 つです。

パラメータ 説明 デバイス

m デバイス多重パラメータ MOSFET

Rg、Rb ゲートおよびバルクオーム抵抗 MOSFET

Rds ドレインソースシャント抵抗 MOSFET

W、L .model ラインで幅および長さの
サポート

MOSFET

Nk ニー電流ロールオフ係数 BJT
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TDMS データファイルのサポート
Multisim は TDMS ファイルの対応が可能になりました。 TDM 電圧および

電流ソースでは、TDM ストリーミングデータファイルを参照し、

Multisim のグラファで TDMS データをエクスポートできます。

NI Circuit Design Suite 10.0.xとのファイルの互換性
NI Circuit Design Suite 10.0.xのファイルと 10.1 は、下位および上位互

換性があります。 ファイルの拡張子は同じで、いずれかのバージョンで保

存したファイルを両バージョンで開くことができます。

NI Ultiboard における新規フォントレンダリング
Ultiboard におけるボードのレイヤーに配置されるフォントが、

Anti-Grain Geometry を使用して描画されるようになりました。 これに

より、より迅速なフォンレンダリングおよびより優れたアンチエイリアス

が提供されます。 

ローカリゼーション
NI Circuit Design Suite 10.1 は、英語、ドイツ語、そして日本語にロー

カライズされています。 システムの地域設定により、ソフトウェアが使用

するデフォルトの言語が決定します。 

ソフトウェアが使用するデフォルトの言語を変更するには、オプション→

グローバル環境設定を選択して、一般タブをクリックし、言語コンボボッ

クスから希望する言語を選択し、アプリケーションを再起動してくださ

い。 

以下のアイテムはローカライズされていません。英語のみでご利用いただ

けます。 

• LabVIEW 計測器。

• NI ELVIS 計測器。

• NI Ultiboard および NI Multisim 両方のスプレッドシートビューのレ

イヤー名。

• Agilent および Tektronix のシミュレートされた計測器。

• サンプルファイル。

• MCU 機能 : ソースファイル名、ソースファイル内のコード / コメン

ト、およびコンパイラ / リンカメッセージ。

以下のドキュメントは、英語、ドイツ語、および日本語に翻訳されていま

す。

• 『リリースノート』

• 『NI Circuit Design Suite スタートアップガイド』

ユーザマニュアルおよびヘルプファイルはローカライズされていません。

英語のみでの使用が可能です。 
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製品層の詳細

以下は、Multisim の Student（学生）版および Education（教育）版で

利用できる回路図キャプチャ機能の一覧です。

機能 学生 教育

カスタマイズ可能な GUI X X

画面キャプチャユーティリティ X X

回路図コメント X X

回路アノテーション X X

モードレス部品の配置と配線 X X

検索しやすい部品箱 X X

自動 / 手動配線 X X

ノード名による仮想配線 X X

部品移動のラバーバンディング X X

高速な自動接続受動機能 X X

サブ回路 X X

3 次元ブレッドボード X X

仮想 NI ELVIS I および II X X

埋め込み式質問 - 表示と応答 X X

Ultiboard とのフォワード / バック
アノテーション

X X

Ultiboard とのクロスプローブ X X

バスベクトル接続 X

スプレッドシート表示 X

設計制約 X

上級検索 X

選択部品のズーム X

コーポレートデータベース X

ユーザ定義フィールド X

ワークスペースからコンポーネント
をデータベースに保存

X

複数の開回路 X
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以下は、Multisim の Student（学生）版および Education（教育）版で

利用できるシミュレーション機能の一覧です。

埋め込み式質問 - 作成と編集 X

電気ルールチェック X

未接続ピンを図でマーク X

階層設計 X

マルチシート設計 X

プロジェクト管理機能 X

レポート - 材料表を含む X

ピン / ゲートスワップ X

Mentor PADS レイアウトへのエク
スポート

X

デバイスライブラリ 一部 全部

設計中の最大コンポーネント 50 制限なし

機能 学生 教育

対話式シミュレーション X X

完全ミックスモード A/D シミュレー
ション

X X

標準 SPICE 3X5/XSPICE X X

強化されたモデルサポート X X

Cadence® Pspice® モデルシミュ
レーション *

X X

速度 / 精度トレードオフ X X

シミュレーションアドバイザ X X

収束アシスタント X X

仮想、対話式、動画部品 X X

対話式部品のマウスクリックサポー
ト

X X

定格コンポーネント X X

コンポーネントへの故障の挿入 X X

測定プローブ X X

機能 学生 教育



© National Instruments Corporation 13 NI Circuit Design Suite 教育版 リリースノート

コンポーネントウィザード X X

NI 測定データファイルソース X X

NI 測定データファイルエクスポート X X

計測器およびソースとしての
NI LabVIEW VI

X X

マイクロホンとスピーカー X X

回路の制限事項 X X

グラファと後処理 X X

RF 設計キット X X

回路ウィザード X

C コードモデリング X

シミュレーションに同期する説明
ボックス

X

梯子ダイアグラム / コンポーネント X

モデル作成 X

シミュレーションプロファイルを
ロードして保存

X

仮想計測器 22 22

解析 10 18

Multisim MCU X X

Multisim オートメーション API X

* Cadence® PSpice® 構文すべてをサポートしません。

機能 学生 教育
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以下は、Ultiboard の Student（学生）版および Education（教育）版

で利用できるレイアウト機能の一覧です。

機能 学生 教育

トレース配置の押し退け X X

部品配置の押し退け X X

リアルタイム銅ラッツネスト X X

リアルタイム多角形更新（取り消し
機能付）

X X

フォワード / バックアノテーション X X

Multisim とのクロスプローブ X X

リアルタイム DRC X X

64 レイヤーおよび 1 ナノメートル分
解能 

X X

包括的なフットプリントウィザード X X

向上したプリント機能付き 3D 視覚
化 

X X

ユーザアノテーション X X

全画面表示モード X

Gerber、DXF、IPC-D-356A、SVG
出力

X

PCB およびランドパターンの寸法 X

データベースマネージャの寸法 X

ネットブリッジ X

回路ボード内の 3D 視覚化 X

選択したネットのラッツネストの

OFF 機能

X

グリッドレス誘導型配置 X

テクノロジファイルをロードして保
存

X

極グリッド X

カスタマイズ可能なレイヤー表示 X

パワープレーンの分割 X

キープイン / キープアウト領域 X
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配列にコンポーネントを配置 X

すべてのコンポーネント配置の取り
消し

X

ルーラバーのアライメントと測定 X

自動アライメント X

PCB 設計をコンポーネントとして保
存

X

永久グループ化 X

ピン / ゲートスワップ X

複数間隔 X

エラーへの移動 X

Equispace トレースサポート X

差動インピーダンス計算 X

伝送ライン計算 X

マイクロビア X

テストポイント挿入 X

自動ティアドロップ X

ピンネックトレースサポート X

自動ジャンパ挿入 X

経路のコピー / 複製の配置機能 X

インプレースフットプリント編集 X

機械 CAD X

3D 情報を 3D IGES、DXF フォーマッ
トでエクスポート

X

銅量レポート X

テストポイントレポート X

レポート生成のカスタマイズ X

複数のオープンドキュメント X

サポートされているピン数 350 1,000

スプレッドシート表示 制限付き 全部

機能 学生 教育



NI Circuit Design Suite 教育版 リリースノート 16 ni.com/jp

以下は、Ultiboard の Student（学生）版および Education（教育）版

で利用できる自動経路設定機能の一覧です。

機能 学生 教育

完全カスタマイズ可能コスト係数 X X

プログレッシブ経路設定 X X

対話式自動経路設定 X X

制約駆動経路設定 X X

手動前配置 : コンポーネント、ビア、
トレース

X X

自動ブロックキャパシタ認識 X X

SMD ミラーリング X X

トレースラバーバンディング X X

キープイン / キープアウト基準に準拠 X X

ピン番号制限 350 1,000

レイヤーの最大数 2 4
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ドキュメント

NI Circuit Design Suite 10.1 には、リファレンスとなる印刷および電子

リソースを含む完全なドキュメントセットが含まれています。

以下の印刷および電子リソースを利用いただけます。

• 『NI Circuit Design Suite スタートアップガイド』

• 『NI Circuit Design Suite リリースノート』

以下の電子リソースは PDF ファイルでご利用いただけます。

• 『Multisim User Manual』

• 『Multisim for Education Manual』

• 『Ultiboard User Manual』

メモ NI Multisim MCU モジュールの機能は NI Multisim に含まれるようになったた

め、『Multisim MCU Module User Guide』は廃止されました。 Multisim MCU
については、『Multisim User Manual』を参照してください。 『Multisim 
Component Reference Guide』は廃止されました。 コンポーネントの詳細に

ついては、『Component Reference Help File』を参照してください。 

ユーザマニュアルにアクセスするには、スタート→すべてのプログラム→

National Instruments → Circuit Design Suite 10.1 → Documentation
を選択して、参照するファイルを選択します。 

以下のオンラインヘルプファイルは、インストール済みのソフトウェアの

ヘルプメニュー、そしてスタートメニューからご覧いただけます。 

• 『Multisim Education Edition Help File』

• 『Ultiboard Help File』

スタートメニューからヘルプファイルにアクセスするには、スタート→すべ

てのプログラム→ National Instruments → Circuit Design Suite 10.1 →

Documentation を選択して、参照するファイルを選択します。 

以下のオンラインヘルプファイルは、インストール済みのソフトウェアの

ヘルプメニューからご覧いただけます。 

• 『Component Reference Education Edition Help File』

• 『Multisim Symbol Editor Help File』（シンボルエディタからアクセ

ス）

• 『Multisim Title Block Editor Help File』（タイトルブロックエディタ

からアクセス） 
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